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The Portlock storage management software described in this document is furnished under a License 
Agreement and may be used only in accordance with the terms of the agreement. 
 
Version: 1.0 
 

Date of Publication: November, 2010 
 
NO WARRANTY. The technical documentation is being delivered to you AS IS and Portlock makes no 
warranty as to its accuracy or use. Any use of the technical documentation or the information contained 
therein is at the risk of the user. Documentation may include technical errors, typographical errors or 
other inaccuracies. Portlock reserves the right to make changes without prior notice. 
 

All technical documentation made available by Portlock is the copyrighted work of Portlock. No part of 
this publication may be copied without the express written permission of Portlock. 
 

Copyright 2000-2010 Portlock. All Rights Reserved. Portlock, the Portlock logo, Portlock Storage 
Manager, Portlock Scorpion, Portlock Volume Defrag, Portlock Disk Test and Portlock Storage Suite are 
trademarks of Portlock. 
 

Other vendor product names mentioned in this manual may be trademarks or registered trademarks of 
their respective companies and are hereby acknowledged. Printed in the United States. 
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Chapter 1. Introduction 
This document describes the steps necessary to virtualize NetWare 6.0 to ESXi. 

Prerequisites 
 NetWare 6.0 Service Pack 5*. 

 VMware ESXi version 4.1. 

 VMware vSphere Client version 4.1. 

 Portlock Storage Manager version 5.06. 

 Portlock License Manager version 5.15. 

 Portlock Boot CD version 5.15 (32-bit). 

 Portlock Device Driver Package for NetWare version 1.0. 

Note: If you are not running at least Service Pack 5, do not try to virtualize NetWare 6.0. Install Service 
Pack 5 first. 

Portlock Storage Manager 
Portlock Storage Manager runs on NetWare servers and is the program that creates images of NetWare 
servers (among its many storage management features). Portlock Storage Manager is a NetWare 
Loadable Module (NLM) and is run from the NetWare console or launched remotely by Portlock License 
Manager. 

Portlock License Manager 
Portlock License Manager is a Windows program that manages Portlock licenses, Portlock products, 
downloads and libraries of objects (Portlock Images, ISO Images, etc.). 

Portlock License Manager provides direct support for NetWare servers. Key features include: 

 Scanning the network for NetWare servers. 

 Displaying NetWare storage objects. 

 Downloading and installing Portlock Storage Manager to a NetWare server. 

 Licensing Portlock Storage Manager on a NetWare server. 

 Script creation wizard. 

 Imaging a NetWare server. 

 Managing Portlock Images. 

 Managing NetWare servers that are part of Novell Clusters Services. 

Portlock Boot CD 
Portlock Boot CD is a complete bootable operating system based upon WinPE 2.1 (Windows Server 
2008). Portlock Storage Manager running on the Portlock Boot CD has nearly the same feature set as 
when running under NetWare. 

Basic Steps for Virtualization 
 Create virtual machine. 
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 Boot the virtual machine with the Portlock Boot CD. 

 Image NetWare server using Portlock License Manager. 

 Restore NetWare server using Portlock Storage Manager on the Portlock Boot CD. 

 Configure NetWare server. 
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Chapter 2. Virtualization Considerations 
There are a number of good reasons to virtualize Novell NetWare: 

 The hardware is out of date.  The Novell NetWare server is running critical applications that 
continue to be needed but the hardware will not reliably last that long. 

 Complex configurations. The NetWare server has a complex configuration that needs to stay the 
same but more resources are required. Virtualizing the server to higher end hardware will help. 

 Simplified backups. A virtual machine can be backed up by just copying the virtual machine disk 
and configuration files. 

 Hardware support. Major hardware vendors are gradually dropping support for NetWare. 
Moving a server to a virtual machine minimizes hardware obsolescence. 

There are valid reasons to not virtualize Novell NetWare: 

 The NetWare server is running poorly on the existing hardware. Correct these problems first 
before virtualizing. 

 The NetWare server is part of a Novell Cluster that is sharing storage hardware. 

 The downtime to virtualize is unacceptable. Depending on the age of the hardware, transfer of 
data can be as low as 2 MB / sec (7 GB per hour). Typically speeds for modern hardware is 
around 50 – 75 GB per hour. 

 Complex network configurations. VMware provides a simple network model that might not 
meet your server’s network configuration. Review your network requirements and make sure 
that VMware supports your requirements and that you understand how to configure the virtual 
machines network configuration. 
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Chapter 3. Preparing for Virtualization 
Novell NetWare 6.0 is legacy operating system that was released prior to the current generation of 
VMware virtualization products. There are several tasks that should be completed in preparation for 
virtualization that will simplify the procedure. Ensure that you have adequate training on both NetWare 
and VMware prior to beginning virtualization. 

A server that is not running stably prior to virtualization, will not run stably after virtualization except in 
cases where the hardware is being replaced by a virtual machine. Ensure that the NetWare server is 
running reliably prior to virtualization. 

Routine Server Maintenance 
 Schedule downtime for the server when it will not need to be accessed. 

 Reboot the server. 

 Check of each partition and volume. 

 Install the latest service pack (SP5) and hotfixes. 

 Review each of the server’s applications and update to the latest versions. 

 Download and install the disk and network drivers that are required for VMware. 

 Document network configuration. 

Schedule Downtime 
In preparing a Novell NetWare server for virtualization, you will need to spend some time ensuring that 
the server is correctly maintained and patched. This may take only a few minutes for servers that have 
been properly maintained to several hours for servers that have not been maintained for a few years. 

Reboot the Server 
It is important to begin the maintenance process with a freshly booted server. This step returns the 
server to a fresh starting state, minimizes lost or fragmented memory, etc. 

Check Partitions and Volumes 
This is an important step and is the number one source of failure while imaging and virtualizing an 
Novell NetWare server. Check and repair any warnings or errors on the DOS partitions, NetWare 
Traditional volumes and NSS Pools. 

A common problem with NSS Pools is “unclaimed blocks”. These are blocks that exist but are not 
assigned to a file system object. Run the NetWare console command “NSS /PoolRebuild” to correct this 
type of error. 

To check and repair DOS partitions, down the server to DOS. Then run either “CHKDSK” for DR-DOS or 
“SCANDISK” for MS-DOS. 

To check and repair NetWare Traditional volumes run the NetWare console command “VREPAIR”. 

To check NetWare NSS Pools run the NetWare console command “NSS /PoolVerify”.  To repair NetWare 
NSS Pools run the NetWare console command “NSS /PoolRebuild”. 
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Once all of the file systems have been checked and repaired, reboot the server. 

Note: Portlock Storage Manager considers any file system consistency warnings to be an error which will 
prevent the virtualization from completing. 

Install Service Pack and Hotfixes 
Portlock does not recommend virtualizing servers that are not correctly patched and updated. 
Numerous problems have been fixed by Novell that might cause problems in virtualizing a system. Install 
the latest service pack and hotfixes prior to virtualization. 

Application Review 
Review each of the applications installed on the server. Remove any that will not be needed after 
virtualization. Update and patch all installed applications. 

Download Required Device Drivers 
This is an important step that will save time later if the correct drivers are not present when the 
virtualized NetWare server first boots. If the correct drivers are not present you might not be able to 
mount the NetWare volumes or setup networking. 
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Chapter 4. Setup Environment 

Step 1. Download and install Portlock Products 
Refer to the Portlock Quick Start Guide for the following steps: 

 Download and install Portlock License Manager on your workstation. 

 Import your Portlock Storage Manager licenses. Note: You will need a license for each NetWare 
server that your virtualize. 

 Download Portlock Storage Manager using Portlock License Manager. 

 Download Portlock Boot CD using Portlock License Manager. 

Step 2. Install Portlock Storage Manger to the NetWare Server 

Method #1 – Portlock Boot CD method 
 Using Portlock License Manager burn the Portlock Boot CD ISO image to a CD. 

 Insert the CD into the drive connected to the NetWare server. 

 At the server console type “volumes”. 

 If the volume “PBCD” does not appear: 
o At the server console type “load iso9660” or “load cdrom”. 
o Wait a few seconds. The system should automatically detect the media in the CD. 

 Once the Portlock Boot CD is mounted launch the Portlock Storage Manger install program: 
o At the server console type “load PBCD:/STORMGR/NETWARE/PINSTALL.NLM” 
o Complete the prompts to install Portlock Storage Manager 

 Launch Portlock Storage Manager Agent: 

 At the server console type “load SYS:/STORMGR/PSMAGENT.NLM” 
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Chapter 5. Virtual Machine Setup 

Step 1. Import the Portlock Boot CD ISO Image 
 Start VMware vSphere Client on your workstation. 

 Click on the “Summary” tab. 

 Under “Resources” right click on the desired datastore such as “datastore1”. 

 Select “Browse Datastore”. 

 On the toolbar select the folder+ icon to create a new folder. 

 Name the folder “PBCD”. 

 Select “PBCD” in the tree window. 

 On the toolbar select the “Upload” icon. 

 Select “Upload File”. 

 Browse to the location where the Portlock Boot CD ISO is located. 

 Complete the import of the Portlock Boot CD ISO. 

Step 2. Create the virtual machine 
 Start VMware vSphere Client on your workstation. 

 Go to File -> New -> Virtual Machine. 

 Enter a name for the virtual machine. 

 Select the datastore 

 Select “Novell NetWare” for the operating system type. 

 Select “Novell NetWare 6.x” for the version. 

 Enter a value for the virtual disk size. 

 Optionally select “Allocate and commit space on demand (Thin Provisioning)”. 

 Select “Edit the virtual machine settings before completion”. 
o Memory: Change the memory Size to be at least 1024 MB. Note: 2048 MB is 

recommended as a minimum during the virtualization phase. 
o CPUs: Leave the setting at 1. 
o Video card: Select “Auto-detect video settings”. 
o VMCI device: No changes required. 
o New CD/DVD: Select “Datastore ISO File”. Click “Browse” and select the ISO image that 

you uploaded into the datastore from Step #1. 
o New CD/DVD: Select “Connect at power on”. 
o New Floppy: Select “Client Device”. 
o New SCSI Controller: No changes required. 
o New NIC: No changes required. 
o New Hard Disk: No changes required. 

 Do not start the virtual machine at this point. 
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Step 3. Modify the virtual machine 
This step is necessary otherwise the virtual machine will hang. In Step #2 above, a new virtual machine 
for Novell NetWare was created. However, the Portlock Boot CD is based upon Microsoft Windows. We 
will now change the guest operating system to “Microsoft Windows”. Once we have completed the 
virtualization of NetWare, the guest  operating system will need to be changed back to “Novell 
NetWare”. 

 Select the virtual machine in the vSphere tree window. 

 Click on the “Summary” tab. 

 Under “Commands” click on “Edit Settings”. 

 Select the “Options” tab. 

 Change the “Guest Operating System” to “Microsoft Windows. 

 Change the “version” to “Windows Server 2008 (32-bit)”. 

 Click OK. 

Step 4. Boot the virtual machine 
 Select the virtual machine in the vSphere tree window. 

 Click on the “Summary” tab. 

 Under “Commands” click on “Power On”. 

 Click on the “Console” tab. 

 Wait for the Portlock Boot CD to boot. This will take approximately two minutes. 

 Note the TCP/IP address displayed in the Portlock Boot CD dialog box. 

Step 5. Install Portlock Storage Manager License 
 Start Portlock License Manager on your desktop. 

 Expand the tree window item “Remote Systems”. 

 Expand the tree window item “Boot CDs”. 

 After approximately 30 seconds after the Portlock Boot CD completes the boot-up process, the 
system should appear in Portlock License Manager under “Boot CDs”. If this does not happen, 
manually add the system using the TCP/IP address noted above in Step #4. 

 Click on the TCP/IP address that corresponds to the booted virtual machine. 

 Right-click and select “Install / Update License”. 

 Select the your Portlock Storage Manager license. 

 Click “Install” to install your license over the network. 

 Go back to vSphere. Go to the “Console” tab. Click on the “Reload license” button to load the 
new license that was just installed. Click on the “License” tab and verify that the correct license 
was loaded by the Portlock Boot CD. Then click “OK”. 

 When the Portlock OS Manager dialog displays, select “Do not attach to an operating system 
installation”. Click “OK”. 

 Suggestion: Click on the Portlock Boot CD taskbar “800x600” to change the display resolution to  
1024 x 786. 
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 The Portlock Boot CD is now booted and ready. 
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Chapter 6. NetWare Server Image Creation 
 

[EDITOR NOTE: This chapter was copied from the Portlock Image Scripting Guide. Update to reflect 
NetWare 6.0 instead of NetWare 5.1] 

Introduction. 
In this example we will use Portlock License Manager to image a NetWare server. Portlock License 
Manager runs on Windows XP SP2, Windows Vista and Windows 7 (x86 and x64 platforms).  

Start Portlock License Manager. Review the opening screen. There are two primary windows. The left 
window provides a tree view of various objects. The right window provides a list view of selected objects 
in the tree view that changes based upon the selection in the left window. 
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Find the item "NetWare Servers" in the tree view. This item will contain the NetWare servers that are 
visible to the workstation. If the desired NetWare server is not displayed, right-click on "NetWare 
Servers", select "Add NetWare Server" and then enter the TCP/IP address or server name of the desired 
NetWare server.  

The list view will display various details of the NetWare servers. In this example, we have four servers 
displayed. One is a NetWare 5.1 SP8 server and the others are a NetWare 6.5 SP8 Cluster. The cluster 
has two servers (CLUSTERA and CLUSTERB). The virtual cluster server is named "cluster". Note that 
Portlock License Manager displays information about the version of Novell Cluster Services version and 
node numbers. 

 

Select the server in the tree view. The list view will change and display information about the NetWare 
volumes that are currently mounted on the server. This information is static - to update, right-click on 
the server name and select "Refresh Server Information". 

 

There are two methods to image a NetWare server. Immediately via the "Image NetWare Server" 
command and via a saved Portlock Image Script. When you select "Image NetWare Server" a script is 
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created and saved under the NetWare server's name. In this example, we will create a script first and 
then execute the script. 

Right-click on the server name in tree view. Select "Create Script Wizard". The wizard displays an 
introductory screen. After reviewing the screen, click Next. 
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The screen shows the name of the NetWare server. When the next button is clicked, Portlock License 
Manager will connect to the NetWare server and launch Portlock Storage Manager. Portlock Storage 
Manager will create a list of storage objects on the server and send this information back to Portlock 
License Manager. This connection requires admin rights to the server. If Portlock Storage Manager is not 
installed on the NetWare server, this phase will fail. To correct this problem cancel the wizard. Then 
right-click on the NetWare server and select "Install Portlock Storage Manager". 
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This screen displays options for the image script. After setting the desired options click Next. 

 Name. This is the name of the script. Do not enter a path name as the script will be stored in the 
tree view under NetWare Servers. 

 Enable image compression. This option enables or disables compression of the data created by 
the image command. 

 Calculate crc32 values for image data. This option enables crc32 checksum information to be 
added to the data created by the image command. During an image restore, the data will be 
verified against the saved crc32 values. 
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This screen displays options that are performed before the image begins. This is done via a NetWare 
batch file (NCF). If desired, specify the full path name to the script located on the NetWare server. 
Portlock License Manager does not create the NCF file. 

In this example, the script "sys:/pre_img.ncf" is specified. This script file contains the following content: 

broadcast "Portlock Storage Manager is starting" 
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This screen displays options that are performed after the image completes. This is done via a NetWare 
batch file (NCF). If desired, specify the full path name to the script located on the NetWare server. 
Portlock License Manager does not create the NCF file. 

There are two additional options that control if the server is rebooted or shutdown after the image 
completes. 

In this example, the script "sys:/post_img.ncf" is specified. This script file contains the following content: 

broadcast "Portlock Storage Manager has completed the server image" 
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This screen displays options for selecting where to store the image. In this example TCP/IP is used. 
Portlock Storage Manager will then image the NetWare server and send the image data over TCP/IP. 
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This screen shows the options for TCP/IP. In this example, Portlock Storage Manager will connect back to 
Portlock License Manager at TCP/IP address 192.168.10.99. If the workstation has more than one TCP/IP 
address, click the pull-down choice box and select the TCP/IP address that has the fastest connection to 
the NetWare server. 

There are several options that can be selected: 

 Server Mode. Portlock Storage Manager will start and then wait for a connection from Portlock 
License Manager. Use this mode when you want to monitor an image command. Normally Client 
Mode is used so that the image command runs in the background in Portlock License Manager. 

 Client Mode connecting to Portlock License Manager. This is the normal mode. Portlock Storage 
Manager will connect to Portlock License Manager and upload the server image. 

 Client Mode. Select this mode when you want to manually specify the TCP/IP address of where 
Portlock Storage Manager will connect to. This could even be the TCP/IP address of another 
system that is running Portlock License Manager. 
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This screen displays the objects that can be imaged. In this example, there are three objects: 

 FAT16 DOS partition. This is the partition that the server boots from. 

 SYS Volume. This is a NetWare Traditional volume holding the operating system. 

 USERS Volume. This is a NetWare NSS volume for the users data on the system. 

The objective in this example is to create a disaster recovery image of the operating system. This needs 
to include the booting DOS partition and the SYS volume. Therefore we select the DOS partition, the SYS 
volume and deselect the USERS volume. 
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This screen displays that all information has been collected. Once the Finish button is clicked, the script 
will be saved in tree view under the item "Scripts". Review the following screens. 
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The script that is created for this example has the following content. Refer to other sections of this 
document for details on each line of this script. 

%Author%  Portlock License Manager Wizard 
%Date%  Friday, March 12, 2010 8:56:43 PM 
%Description%  This script was generated by the Portlock License Manager Wizard 
%Version%  1.0.0 
# 
-script 
-exec_ncf_0="sys:/pre_img.img" 
-exec_ncf_1="sys:/post_img.img" 
-imagetcp=client=192.168.10.99 
-compression=5 
-crc32=1 
-image_dos="DRDOS" 
-image_vol=SYS 

 

Now that the script has been created, the script can be executed at any time. Select the script in the tree 
view, right-click and select "Image NetWare server using this script". The following steps will occur: 

 Portlock License Manager will open a connection to the NetWare server. 

 Portlock License Manager will copy the script to the server with the destination file name 
"sys:/script.txt".  

 Portlock Storage Manager will then be launched with the option "-script=sys:/script.txt". 

 Portlock Storage Manager will first execute the script command "-exec_ncf_0". 

 Portlock Storage Manager will connect to Portlock License Manager using the TCP/IP address 
192.168.10.99. 

 Portlock License Manager will accept the connection, verify the NetWare server name and 
create a directory to receive the image. 

 Portlock Storage Manager will then image the server using the commands in the script. The 
image data will be transferred to Portlock License Manager over TCP/IP. 

 Portlock Storage Manager will execute the script command "-exec_nf_1". 
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When Portlock License Manager accepts the connect from Portlock Storage Manager, the status window 
will be displayed. The status window displays status for current and previous uploads and downloads 
since program start. 

In this example, a complete disaster recovery image of the NetWare 5.1 SP8 server took 3 minutes 43 
seconds. Using this image, a NetWare server can be restored from bare-metal in just a few minutes. All 
critical information including NDS, server and user IDs, trustees, directory restrictions, etc are saved in 
the image. 
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Portlock Images are stored in the tree view under "Portlock Image Library". Under this item is the name 
of the server and the date of the image. When the image is selected in the tree view, details about the 
image are displayed in the list view.  

To restore a NetWare server from a Portlock Image, select the image in the tree view, right-click and 
select "Send Portlock Image". Then boot the system to be restored with the Portlock Boot CD, start 
Portlock Storage Manager and restore the server selecting "Portlock License Manager" as the restore 
source. 
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Chapter 7. NetWare Server Migration and Virtualization 

Step 1. Send Portlock Image 
 Start Portlock License Manager on your desktop. 

 Expand the tree window item “Portlock Image Library”. 

 Expand the tree window item “NetWare”. 

 Expand the tree window item that represents your NetWare server from Chapter 5. 

 Expand the tree window item that represents the image from the NetWare server. 

 Right-click on “portlock.img” and select “Send Portlock Image”. 

 Note the TCP/IP address and the “secret key” displayed in the dialog box above the OK 
button. 

 Press “OK”. 

Portlock License Manger will now listen for connections from Portlock Storage Manager. 

Step 2. Restore from the Portlock Image 
 Select the virtual machine in the vSphere tree window. 

 Click on the “Console” tab. 

 Locate the icon for “Portlock Storage Manager” in the Portlock Boot CD GUI. 

 Click on the icon to start Portlock Storage Manager. 

 Verify your license in the Portlock License Manager license dialog. Press ENTER. 

 Select “NetWare” in the “Select operating system to manage” dialog. Press ENTER. 

 Select “NetWare 6.0. Press ENTER. 

 If Portlock Storage Manager displays a prompt regarding the “Master Boot Record” select 
“Install boot code” and press ENTER. 

 Normally you would select “DR-DOS (NetWare Servers)” for the booting operating system 
type. Note: Some NetWare servers have MS-DOS installed. Select the correct platform and 
press ENTER. 

 At the Portlock Storage Manager main menu, select “Restore Commands”. Press ENTER. 

 Select “Read image from Portlock License Manager”. Press ENTER. 

 Enter the TCP/IP address for Portlock License Manager that you saved in Step #1. 

 Enter the secret key in the “Key” field. Press F-10. 

 Portlock Storage Manager will now connect to Portlock License Manager. 

 For the “Enter the NetWare File Server Name” dialog, enter any name (it does not matter at 
this point). For example, enter “TEST”. Press ENTER. 

 Portlock Storage Manager will now download the list of items that can be restored. Press F-
5 to toggle between restoring or skipping an item. 

 Press ENTER when ready to restore. 

Complete the restore of each partition, pool and volume. Once the restore completes, exit 
Portlock Storage Manager. 
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Step 3. Shutdown the virtual machine 
 Click the “Shutdown System” label in the Portlock Boot CD GUI. There is also a “Shutdown” 

button on the Portlock Gadget toolbar. 

Step 4. Modify the virtual machine 
This step is necessary otherwise one or more of the follow symptoms will occur: 

 The virtual machine will hang. 

 The mouse will not work in the NetWare GUI. 

 The volume mounted for VMware Tools is “VMWARETOOLS” instead of “VMWTOOLS”. 

Now that we have completed the virtualization of NetWare, the guest  operating system needs to be 
changed back to “Novell NetWare”. 

 Select the virtual machine in the vSphere tree window. 

 Click on the “Summary” tab. 

 Under “Commands” click on “Edit Settings”. 

 Select the “Hardware” tab. 

 Select “CD/DVD Drive” in the left column under “Hardware”. 

 Unselect “Connect at power on” to disconnect the Portlock Boot CD ISO file. 

 Select the “Options” tab. 

 Change the “Guest Operating System” to “Novell NetWare”. 

 Change the “version” to “Novell NetWare 6.x”. 

 Click OK. 

Step 5. Boot the virtual machine 
 Select the virtual machine in the vSphere tree window. 

 Click on the “Summary” tab. 

 Under “Commands” click on “Power On”. 

 Click on the “Console” tab. 

 Wait for the NetWare virtual machine to boot. 
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Chapter 8. Post Migration Setup 

Step 1. Configure storage drivers 
 Once the NetWare virtual machine boots, you will have a “:” prompt at the server console. 

 At the server console, type “edit C:STARTUP.NCF” 
o Delete all lines in the editor. 
o Press the ESC key and then select “Yes” to save the file. 
o Press the ESC key to exit the editor. 

 At the server console, type “HDETECT”. This will start the hardware detection program. 
o HDETECT will complain that the SYS volume is not mounted. Ignore this error and 

continue to load drivers. 
o HDETECT will now display a screen for Platform and HotPlug support modules.  
o Select “Modify” and press ENTER. 
o Scroll to “Platform Support Module” and press F-3. 
o Scroll to “HotPlug Support Module” and press F-3. This normally will not do anything 

under VMware. 
o Scroll to “Continue” and press ENTER. 
o HDETECT will now display a screen for Storage and Network boards. 
o Scroll to “Storage adapters” and press F-3. 
o Scroll to “Load” to load the storage adapters. 
o Scroll to “Storage devices” and press F-3. 
o Scroll to “Load” to load the storage devices. 
o Scroll to “Network boards” and press F3. If nothing appears then ignore this issue for 

now. 
o Scroll to “Continue” and press ENTER. 
o HDETECT will save the driver configuration. 

 Reboot the server. 
o At the server console, type “reset server”. The server will now reboot. 

Step 2. Configure network drivers 
 Once the NetWare virtual machine boots, you will have a “:” prompt at the server console. 

 At this point the SYS volume should be mounted. AUTOEXEC.NCF will have been executed. 
Ignore any network errors at this point. Ignore any applications that depend on networking that 
report errors. 

 At the server console, type “HDETECT”. This will start the hardware detection program. 
o HDETECT will now display a screen for Platform and HotPlug support modules.  
o Select “Continue” and press ENTER. 
o HDETECT will now display a screen for Storage and Network boards. 
o Scroll to “Network boards” and press F3.  
o If nothing appears then the Intel E1000 driver “CE1000.LAN” is missing from the system. 
o Scroll to “Continue” and press ENTER. 
o HDETECT will now display a screen for configuring network protocols. 



NetWare 6.0 Virtualization Version 1.0 11/17/2010 
 

Copyright 2000-2010 Portlock Corporation  Page 31 of 35 

o Scroll to “Configure protocols” and press ENTER. 
o Select the “CE1000.LAN” entry and press ENTER. 
o Scroll to the line displaying “Ethernet_II” and press ENTER. 
o Scroll to “IP Address” and enter the TCP/IP address for the server. Press ENTER and then 

ESC. 
o Review the “Subnet Mask” and “Router (Gateway)” entries. Correct as needed. 
o Scroll to “Continue” and press ENTER. 
o Scroll to “Return to driver summary” and press ENTER. 
o Scroll to “Continue” and press ENTER. 
o HDETECT will load the network driver and bind protocols. A dialog box will optionally 

appear to confirm removing incorrect entries from AUTOEXEX.NCF. 

 Reboot the server. 
o At the server console, type “reset server”. The server will now reboot. The server should 

boot normally with storage and network drivers loaded, volumes mounted and TCP/IP 
networking working. 

Step 3. Install VMware Tools 
 Right-click on the virtual machine in the vSphere tree window. 

 Select “Guest” and then “Install / Upgrade VMware Tools”. 

 Switch to the NetWare server console and type “volumes”. 

 If the volume “VMWTOOLS” is mount mounted, type “cdrom” at the server console. Wait a few 
seconds and the volume should mount. 

 At the server console type “VMWTOOLS:/setup.ncf” 

 The VMware Tools are now installed. 

Step 4. Review boot errors 
 Review SYS:/ETC/CONSOLE.LOG for errors. 

Step 5. Review VMware Event Messages 
 Select the virtual machine in the vSphere tree window. 

 Click on the “Events” tab. 

 Review the messages for warnings and errors. 
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Appendix A. Driver Versions 
 

Driver NW 4.11 SP9 NW 5.1 SP8 NW 6.0 SP5 NW 6.5 SP8 Latest Driver 
MPS14.PSM  2.09.01 – 

8/11/2003 
2.09.01 - 
8/11/2003 

  

LSIMPTNW.HAM  3.08 – 
12/11/2004 

3.04.25 - 
12/12/2003 

5.02 - 
12/5/2007 

5.03.01 - 
1/23/2008 

IDECD.CDM 2.0.0 – 
5/26/2000 

4.04 – 
9/30/2004 

4.00 - 
4/24/2004 

4.13 - 
4/4/2007 

 

SCSIHD.CDM 3.0.0 - 
5/3/2000 

3.02i – 
12/17/2004 

3.02.06 - 
4/21/2004 

3.03.10 - 
5/30/2008 

 

IDEATA.HAM 1.30.16 – 
6/9/1999 

4.21 – 
1/15/2005 

4.15 - 
6/4/2004 

4.34 - 
5/5/2007 

 

IDEHD.CDM 3.0.1 – 
5/18/2000 

 4.12 - 
4/24/2004 

4.22 - 
4/4/2007 

 

ACPIDRV.PSM    1.05.19 - 
1/16/2007 

 

CE1000.LAN 2.18.0 – 
5/1/2000 

7.63 – 
12/12/2004 

7.34 - 
3/12/2004 

 7.65.0 - 
1/10/2005 

PCNTNW.LAN 4.18.0 – 
1/5/2000 

    

 

Note: For NetWare 4.11 install nwpa_up.exe to update the drivers beyond SP9. 

http://developer.novell.com/devres/storage/drivers/nwpa_up.exe 

 

  

http://developer.novell.com/devres/storage/drivers/nwpa_up.exe
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Appendix B. Example STARTUP.NCF 
 
For VMware ESX / ESXi, NetWare requires the LSIMPTNW.HAM driver for the SCSI 
storage controller. 
 
LOAD MPS14.PSM  
######## End PSM Drivers ######## 
LOAD IDECD.CDM  
LOAD SCSIHD.CDM  
######## End CDM Drivers ######## 
LOAD IDEATA.HAM SLOT=10008  
LOAD LSIMPTNW.HAM SLOT=2  
######## End HAM Drivers ######## 
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Appendix C. Example Network Driver Configuration 
 
This example is part of AUTOEXEC.NCF except when INETCFG is used to configure 
the network configuration. 
 
For VMware ESX / ESXi, NetWare requires the CE1000.LAN driver for the network 
controller. 
 
######## Start Drivers/Protocols ######## 
SERVERID 943B0A3 
LOAD ODINEB.NLM 
LOAD IPXRTR 
LOAD IPXRTRNM 
LOAD TCPIP 
LOAD CE1000.LAN SLOT=3 FRAME=Ethernet_802.2  NAME=CE1000_1_E82  
LOAD CE1000.LAN SLOT=3 FRAME=Ethernet_II     NAME=CE1000_1_EII  
BIND IP CE1000_1_EII ADDR=10.1.10.45 MASK=255.255.255.0 GATE=10.1.10.1  
BIND IPX CE1000_1_E82 NET=EA754A94  
######## End Drivers/Protocols ######## 
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Appendix D. Tips & Common Problems 

The Portlock Boot CD hangs when starting a virtual machine 
You forgot to change the “Guest Operating System” to Windows. See Chapter 5, Step 3 “Modify the 
virtual machine”. 

Also review this document: http://www.portlock.com/support/knowledge_base/boot_VMware.aspx 

The NetWare server’s date and time is wrong after virtualization 
Setup NTP (Network Time Protocol) on the VMware ESXi server. Refer to this VMware document: 
http://www.vmware.com/files/pdf/Timekeeping-In-VirtualMachines.pdf 

After restoring NetWare, the SYS volume is not mounted. 
NetWare requires the LSI Logic driver LSIMPTNW.HAM to access the VMware SCSI controller. Review 
the steps in Chapter 8, Step 1 “Configure storage drivers”. Also review Appendix B, “Example 
STARTUP.NCF”. 

http://www.portlock.com/support/knowledge_base/boot_VMware.aspx
http://www.vmware.com/files/pdf/Timekeeping-In-VirtualMachines.pdf
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